Resource Account Instructions

Managing a Resource Email Account in Outlook 2007, 2010, 2011, or 2013

Contents: click to skip to a section

Overview of Resource Accounts for Owners ................................................................. 2
Email Retention and Archives ...................................................................................... 3
  Default 90-Day Option ............................................................................................ 3
  18-Month Option ...................................................................................................... 3
  5-Year Option ........................................................................................................... 3
Accessing a Resource Account: three ways ............................................................... 4
  #1 Opening a Resource Account in a Browser with OWA ........................................ 5
    Log into OWA ....................................................................................................... 5
    Switching between accounts in OWA ................................................................. 5
  #2 Create a Profile in Outlook ................................................................................ 6
    Windows XP ....................................................................................................... 6
    Windows 7 .......................................................................................................... 7
    Windows 8 .......................................................................................................... 11
    Mac OS X ........................................................................................................... 14
  #3 Open as an Additional Mailbox & Create Sent Item Rule .................................. 16
    Create a Sent Item Rule .................................................................................... 16
    Outlook 2007 ..................................................................................................... 17
    Outlook 2010 ..................................................................................................... 18
    Outlook 2011 for Mac ......................................................................................... 20
    Outlook 2013 ..................................................................................................... 22
Delegate Permissions for Other Users .................................................................... 25
  Assigning Access to Delegates ............................................................................ 25
    Outlook 2007 ..................................................................................................... 26
    Outlook 2010 ..................................................................................................... 27
    Outlook 2011 for Mac ......................................................................................... 30
    Outlook 2013 ..................................................................................................... 31
Add an Additional Mailbox: for delegates .............................................................. 33
  Outlook 2007 ..................................................................................................... 33
  Outlook 2010 ..................................................................................................... 34
  Outlook 2011 for Mac ......................................................................................... 36
  Outlook 2013 ..................................................................................................... 38
Overview of Resource Accounts for Owners

As the owner of an email resource account, you can access your account email using the Outlook desktop application (Outlook 2007, 2010, 2011, or 2013) or online via the Outlook Web Application (OWA) at http://outlook.depaul.edu.

As the owner, you have full rights or “send as” permission for this mailbox. This means that you can send and receive messages from this account. You also have the ability to give other users permission to access the resource account. These other users with access the account are known as delegates. If your delegates only need access to read messages in the account, but will not send messages from the account, you can assign delegate access yourself. If any of your delegates require the ability to send email from this account, also known as "send as" rights, you must request these privileges from Netadmin at netadmin@depaul.edu.

As the owner, you also have the choice of three email retention/archive policy options. By default, all new resource accounts are assigned to the 90-Day Email Retention and Archive Option. If you would like to retain email in the account longer, you may request either the 18-Month or 5-Year Option.
Email Retention and Archives

Owners of resource accounts may choose from three email archive and retention policies. The default 90-day policy will be applied to your account automatically. To choose either the 18-month policy or the 5-year policy, please fill out the Email Retention Policy Change Request Form.

Default 90-Day Option

- Applied to resource mailboxes by default. Do nothing to select this option.
- Messages will be deleted 90 days from the original send/receive date.
- The date that a message will be deleted from the inbox is listed in the message.
- Messages will not be archived.

18-Month Option

- Applies to mailboxes where the owner has selected the 18 month archive and retention option.
- Messages will be moved to the online archive 90 days from the original send/receive date.
- Messages will be deleted from the online archive 18 months from the original send/receive date.
- The date that a message will be deleted from the online archive is listed in the message.
- Items in 'Deleted Items', 'RSS Feeds', and 'Sync Issues' folders will be deleted after 90 days.
- Your online archive is located beneath your inbox, in both Outlook 2007 and 2010 for Windows and the Outlook Web Application. Your online archive is not available in Outlook 2011 for Mac.
- Only the owner of a mailbox has access to the archive, not users with delegate access.

5-Year Option

- Applies to mailboxes where the owner has selected the 5 year archive and retention option.
- Messages will be moved to the online archive 90 days from the original send/receive date.
- Messages will be deleted from the online archive 5 years from the original send/receive date.
- The date that a message will be deleted from the online archive is listed in the message.
- Items in 'Deleted Items', 'RSS Feeds', and 'Sync Issues' folders will be deleted after 90 days.
- Your online archive is located beneath your inbox, in both Outlook 2007 and 2010 for Windows and the Outlook Web Application. Your online archive is not available in Outlook 2011 for Mac.
- Only the owner of a mailbox has access to the archive, not users with delegate access.
- If you need to retain your messages beyond 5 years, you will need to do a manual archive of your inbox annually.
Accessing a Resource Account: three ways
Options for accessing a resource account in Outlook for resource account owners

There are three ways for resource account owners to access their resource accounts:

1. in a web browser using the Outlook Web App (OWA) at http://outlook.depaul.edu
2. create a profile in Outlook for your resource account
3. as an additional mailbox from your primary profile in Outlook

#1 Outlook Web App (OWA)

You have the option of logging into your resource account from a web browser on any computer connected to the internet, using OWA. Although most people do not use this as their primary method of checking their resource account email while on campus, it is a convenient method when you are away from the office.

#2 Create a Profile in Outlook

The first thing you should do to access this resource account is to create a mail profile for the resource account. You will want to log into Outlook using this profile whenever you want to make any changes to your resource account. Examples of such changes that you would require you to log into your resource account’s profile include editing rules, adding delegates, or setting permissions. Please see below for instructions on how to create a profile in Windows XP, Windows 7, Windows 8, and Mac OS X.

#3 Open as an Additional Mailbox

The third method for opening your resource account is to open it as an additional mailbox in primary Outlook profile. As an owner, you should be able to see your resource account’s inbox next to your primary email address inbox, without logging into your resource account separately. Many people use this as their primary method of accessing their resource account when logged into a DePaul computer, because of the convenience of being able to switch between inboxes without closing and reopening Outlook.

If either you or your delegates will be accessing the resource account using this method, you will also need to make sure to create a sent items rule, which will move messages into the resource account’s sent items folder.

Note that when you access your resource account while logged into your primary email profile, you will not be able to change certain settings on your account, such as adding delegates. For access to these account settings, you will need to open your resource account using a separate resource account profile, as described in #2.
#1 OPENING A RESOURCE ACCOUNT IN A BROWSER WITH OWA

Using the Outlook Web App (OWA) to open a resource account in a web browser

**Log into OWA**

❖ Note:
To open a resource account in OWA, you must be the owner or have full “send as” rights for the account.

Navigate to:
https://outlook.depaul.edu/owa/resourcename@depaul.edu
substituting the name of your resource account for “resourcename.”

Sign in with your Campus Connect username and password.

**Switching between accounts in OWA**

1. Log into OWA with your Campus Connect username and password as described above or at https:\outlook.depaul.edu.

2. Once you have signed into OWA, click your username in the window’s upper right corner.

3. Type the username of the account you wish to open.

4. Click Open.
The first thing you should do to access this resource account is to create a mail profile for the resource account. This is the method of accessing your account to use whenever you want to make any changes to your resource account, such as adding delegates or setting permissions. Please see below for instructions on how to create a profile in Windows XP, Windows 7, Windows 8, and Mac OS X.

**Windows XP**

4. Click on *My Computer > Control Panel > Mail > Show Profiles*

5. Click the *Add* box.

6. Enter the name of the e-mail resource. Click *Ok*.

7. Choose *Add a new e-mail account*, and click *Next*.

8. Select Microsoft Exchange Server. Click *Next*.

9. At *Microsoft Exchange Server*, enter *exchange.depaul.edu*.

10. Uncheck the *use cached exchange mode* box.

11. At *User Name*, enter the name of the resource, and click *Check Name*. The name of the resource should now show up with an underline. Click *Next*.

12. Congratulations! Successful should appear. Click *Finish*.

13. You should see a dialog box, which shows the profiles that are set-up on your computer. Make sure the *Prompt for a profile to be used* box is checked. Click *Ok*.

14. Launch *Microsoft Office Outlook*. You should see a Choose Profile dialog box. Click the arrow and choose the profile for the resource name you just created. Click *Ok*.

15. You are now logged in the e-mail resource.

16. Whenever you would like to log into your resource account, you can open Outlook using this profile. For information on how to view your resource account without logging into this profile continue with the instructions for *opening your resource account as an additional mailbox*.
Windows 7

1. Navigate to Control Panel and select Mail (32-bit).

2. Select Show Profiles…

3. Select Prompt for a profile to be used.

4. Click Add.
5. Type in the name of your resource account and click **OK**.

6. Select **Manually configure server settings or additional server types**. Click **Next**.

7. Select **Microsoft Exchange or compatible service**, and click **Next**.
8. For Server, enter dpu.depaul.edu.

9. Ensure that Use Cached Exchange Mode is selected.

10. In the User Name field, enter the full e-mail address of the resource account. Click Check Name.

11. The system will underline the exact server name and resource account name to confirm that it is correct. Click Next.

12. Click Finish.
13. Click **OK**.

14. Open **Outlook**. You will notice a drop down menu that gives you the option to select which account you would like to open. Select the resource account from the list and click **OK**.

15. Microsoft Outlook will automatically set up a local copy of your mailbox.

16. Whenever you would like to log into your resource account, you can open Outlook using this profile. For information on how to view your resource account without logging into this profile continue with the instructions for **opening your resource account as an additional mailbox**.
Windows 8

17. Click the Windows logo key to open the Start screen.


19. As you are typing a list of search results will appear. Click the Control Panel tile.


21. Select Prompt for a profile to be used.

22. Click Add.
23. Type the name of your resource account.

24. Click **OK**.

25. Select **Manual setup or additional server types**.

26. Click **Next**.

27. Select **Microsoft Exchange Server or compatible service**.

28. Click **Next**.

29. For **Server**, enter:  
   [dpu.depaul.edu](http://dpu.depaul.edu)

30. For **User Name**, enter the exact name of your resource account.
31. Click **Check Name**.
   Outlook will automatically identify the correct server and the correct resource account.

32. Click **Next**.

33. Click **Finish**.

34. Click **OK**.

35. Click the **Windows logo key** to open the **Start** screen.

36. Click the **Outlook 2013 tile**. This will open Outlook 2013.

37. Each time you open Outlook, you will notice a drop down menu that gives you the option to select which account you would like to open. Select the resource account from the list and click **OK**. Outlook 2013 will automatically set up a local copy of the resource account and you can begin to use your resource account profile.

38. Whenever you would like to log into your resource account, you can open Outlook using this profile. For information on how to view your resource account without logging into this profile continue with the instructions for **opening your resource account as an additional mailbox**.
Mac OS X

1. From the Tools menu, select Accounts…

2. The Accounts window will open. Click the + icon in the bottom left corner.

3. Select Exchange… from the drop down menu.

4. In the popup window, enter the full e-mail address for the resource account.

5. Make sure that User Name and Password is selected.

6. In the User name field, enter dpu\username substituting your Campus Connect username for username. In the Password field, enter your Campus Connect password.

7. Make sure that Configure automatically is checked.

8. Click Add Account.
9. The account name should appear in your list of Default Accounts on the left-hand side of the window.

10. Look at the right-hand column of this window. Outlook assigned a default “account description” to your account; it may say something similar to “DePaul 2.” You might want to change this account description to something that you will recognize. This name will be on the inbox and will distinguish it from your other inboxes.

11. To close the window, click the red x in the top left-hand corner.

12. Whenever you would like to log into your resource account, you can open Outlook using this profile. For information on how to view your resource account without logging into this profile continue with the instructions for opening your resource account as an additional mailbox.
#3 OPEN AS AN ADDITIONAL MAILBOX & CREATE SENT ITEM RULE

The third method for opening your resource account is to open it as an additional mailbox in primary Outlook profile. As an owner, you should be able to see your resource account’s inbox next to your primary email address inbox, without logging into your resource account separately. Many people use this as their primary method of accessing their resource account when logged into a DePaul computer, because of the convenience of being able to switch between inboxes without closing and reopening Outlook.

Note that when you access your resource account while logged into your primary email profile, you will not be able to change certain settings on your account, such as adding delegates. For access to certain account settings you will need to open your resource account using a separate resource account profile, as described in #2 Create a Profile in Outlook.

Create a Sent Item Rule

If either you or your delegates will be accessing the resource account using this method, you will need to make sure to create a sent items rule, which will move messages into the resource account’s sent items folder.

If you send an email from your resource account after you log into Outlook using your resource account profile, as described in option #3, the message will automatically move into the resource account’s sent items folder. However, if you send a message from the resource account while logged into your primary email profile as described here in option #2, the message will move to your primary email account’s sent items folder. Likewise, if a resource account delegate sends a message from the resource account the message will be in their sent items folder, not the resource account’s sent items folder.

In order for sent messages to appear in the resource accounts sent items folder, the resource account owner will need to create the following sent items rule. Anytime someone sends a message from the resource account without being logged directly into the resource account profile, they will need to CC or BCC the resource account on the message. Outlook will send the message to the resource account’s inbox, and the rule will move that message from the inbox to the sent items folder.

Please see below for instructions on how to create a sent item rule in Outlook 2007, 2010, 2011 for Mac, and 2013.
Outlook 2007

1. From the resource go to Tools > Rules and Alerts > New Rule
2. Select a template: Stay Organized section
   Move messages from someone to a folder (highlighted)
3. To edit the rule description, click an underlined value section. Click People or distribution list.
4. The address book will appear. Choose the resource name from the address book. Double click (make sure it is underlined in the box titled from.) Click Ok.
5. Click Move it to the specified folder. Double-click the Sent Items folder. Click Next.
6. From people or distribution list should already be checked. Click Next.
7. Move it to the specified folder should already be checked. In this same section, navigate down and check stop processing more rules. Click next, next, finish.
8. Very Important Note: When the delegates respond to any e-mail from the resource email account they must either cc or blind copy the resource name or reply ALL. This way a copy of the sent item will be in the resource sent items folders. There will also be a copy of the sent item in the user’s personal sent folder.
Outlook 2010

1. Open Outlook 2010 by selecting your resource account profile.

2. In the Home ribbon tab, in the Move group, click Rules, and Manage Rules & Alerts...


4. Move messages from someone to a folder should already be selected.

5. At the bottom of the window, click people or public group.

6. Type the name of your resource account. Click Go.

7. Select the resource account name from the list below.

8. Click From->, then click OK.
9. Click specified.

10. In the pop-up window, find and select the Sent Items folder for your resource account. This is the folder where your resource account sent messages will be moved. Be sure that the sent items folder you select is for the correct resource account and not your primary mailbox.

11. Scroll down and ensure that on this computer only is not selected.

12. Click OK.

13. Select Next > three times.

14. Specify a name for this rule. This will help you find the rule later if you need to edit the rule.

15. Ensure that Turn on this rule is selected.

16. Review the rule description.

17. Click Finish.

18. Click OK.
Outlook 2011 for Mac

Note: If you switch between Outlook for Windows and Outlook for Mac, create your Rule using Outlook for Windows. Using Outlook for Mac to edit rules might delete rules that were created in Outlook for Windows. To avoid deleting any rules, use the directions on the previous pages to create the rule in Outlook 2007, 2010, or 2013 for Windows.

1. In the navigation pane, to the left-hand side of your window, select your resource account mailbox.

2. In the Home ribbon tab, click Rules, then select Create Rule.

3. Next to Rule name type a name for the rule, so that you can refer back to it later if needed.
4. Look under the title *When a new message arrives that meets all these conditions:* In the first line, select **From** and **Is**. If there is a name in the next field, delete it and start typing the name of your resource account. As you start typing, Outlook will search your contacts and the DePaul global address book. Click the name of your resource account when you see it.

5. In the next line, select **Sent To** and **Is**. If there is a name in the next field, delete it and start typing the name of your resource account. As you start typing, Outlook will search your contacts and the DePaul global address book. Click the name of your resource account when you see it.

6. If there are any additional lines below, click the round minus Θ button to delete them.

7. Under the title **Do the following:** select **Move to Folder**. Click the next field and select **Choose Folder**.

8. In the **Search** box, type **Sent Items**. Select the **Sent Items** folder for your resource account. This is the folder where your resource account sent messages will be moved. Be sure that the sent items folder you select is for the correct resource account and not your primary user account. Click **Choose**.

9. Ensure that **Enabled** is checked. Click **OK**.

10. If a disclaimer window pops-up, please read the message. If you have already created any rules for your account in Outlook for Windows, click **Cancel** and use the directions on the previous pages to create the rule in Outlook 2007 or Outlook 2010 for Windows. If you primarily use Outlook for Mac, and have not previously created any rules using Outlook for Windows, click **OK**.
Outlook 2013

1. Open Outlook 2013. In the navigation pane on the left-hand side of the Outlook window, select your email address.

2. In the ribbon’s Home tab, click Rules.

3. From the drop-down menu, select Manage Rules & Alerts.


5. Select Move messages from someone to a folder, if not already selected.

6. At the bottom of the window, click people or public group.
7. Type the name of your resource account.

8. Select the name of your resource account from the list.

9. Click From->, then click OK.

10. If a warning window pops up, click No.

11. Click specified.

12. In the pop-up window, find and select the Sent Items folder for your resource account. This is the folder where your resource account sent messages will be moved. Be sure that the sent items folder you select is for the correct resource account and not your primary mailbox.

13. Click Ok.

14. Scroll down and ensure that on this computer only is not selected.

15. Select Next > three times.
16. Specify a name for this rule. This will help you find the rule later if you need to edit the rule.

17. Ensure that **Turn on this rule** is selected.

18. Review the rule description.

19. Click **Finish**.

20. Click **OK**.
Delegate Permissions for Other Users

Instructions for Assigning Rights to a Delegate in Outlook

ASSIGNING ACCESS TO DELEGATES

As an owner of a resource account, you have the ability to give other users permission to access the resource account. These other users with access to the account are known as delegates. If your delegates only need access to read messages in the account, but will not send messages from the account, you can assign delegate access yourself using Outlook 2007, 2010, 2011 for Mac, or 2013.

Note:
If you have given Author or Editor permission levels for your mail or calendar to your delegate, they will be able to send items on your behalf. However, email and meeting requests sent by your delegate will be displayed as the delegate’s name on behalf of your name in the From field. For example:

From: Jane Jones on behalf of Sample Department

If your delegate needs to be able to send messages directly from the resource account, they will need “send as” rights. The account owner must request full “send as” from Netadmin by emailing netadmin@depaul.edu. Only Netadmin can give the “send as” rights to users.

If any of your delegates require the ability to send email from this account, also known as “send as” rights, you must request these privileges from Netadmin. See the sidebar for more information.

Once you have assigned delegate access to another user, be sure to provide them with the instructions for adding an additional mailbox.
Outlook 2007

1. Open Outlook and selecting your resource account as the profile.

2. Right click on Mailbox-‘your resource name’ > sharing > permissions.

3. Verify the user names and the level of permission each user has. For each item (Calendar, Tasks, Inbox, Contacts, Notes, Journal) select the level of permission you want to grant:
   - **None**: delegate cannot access this feature of your account
   - **Reviewer**: delegate can read items
   - **Author**: delegate can read and add items
   - **Editor**: delegate can read, modify and add items

4. Click **OK**.

5. Navigate down to the Inbox folder and do the same thing you just did for mailbox folder.

6. Provide each of your delegates with the instructions for adding an additional mailbox.
Outlook 2010

1. Open Outlook, selecting your resource account as the profile.

2. In the orange File ribbon tab, click Info, then Account Settings, and Delegate Access. Click Add.

3. In the Add Users window, select the username of the delegate(s) and click Add then click OK.
4. Once you have selected a delegate, you need to set the level and type of permission that delegate will have. For each item (Calendar, Tasks, Inbox, Contacts, Notes, Journal) select the level of permission you want to grant:
   - **None**: delegate cannot access this feature of your account
   - **Reviewer**: delegate can read items
   - **Author**: delegate can read and add items
   - **Editor**: delegate can read, modify and add items

5. Click **OK** and **OK** again.

6. In your folder list, right-click on your Inbox, and click **Properties**.

7. In the **Permissions** tab, click **Add**.
8. Select the username of the delegate and click OK.

9. Select the delegate and in the **Permission Level** drop-down menu select **Reviewer**. Click OK.

10. Provide each of your delegates with the instructions for adding an additional mailbox.

---

**To Edit Permissions in the future:**

1. In the orange **File** ribbon tab, click **Info**, then **Account Settings**, and **Delegate Access**.

2. To remove delegate access, click **Remove**. Or, to edit a delegate’s permission levels, select the user and click **Permissions...**

3. Edit permission levels as above. Then, click **OK** and **OK** again.
Outlook 2011 for Mac

1. Click the Tools drop-down menu, and select Accounts.

2. On the left, select the account to which you would like assign someone access.

3. Click Advanced.

4. Click the Delegates tab.

5. In the top half of the window, under Delegates who can act on my behalf: click Add +.

6. Type the name of the person who has added you as a delegate, and then click Find.

7. Click the delegate’s name, and then click OK.

8. Once you have selected a delegate, you need to set the level and type of permission that delegate will have. For each item (Calendar, Tasks, Inbox, Contacts, Notes, Journal) select the level of permission you want to grant:
   - **None**: delegate cannot access this feature of your account
   - **Reviewer**: delegate can read items
   - **Author**: delegate can read and add items
   - **Editor**: delegate can read, modify and add items

9. Click OK. Click OK, again.

10. Provide each of your delegates with the instructions for adding an additional mailbox.
Outlook 2013

1. Open Outlook, selecting your resource account as your profile.

2. Click the File tab of the Outlook 2013 ribbon.

3. Click Account Settings and select Delegate Access.

4. Click Add.
5. An Add Users window will open. Search for the name of the delegate whom you would like to add. Select their name.

6. Click **Add ->**

7. Click **OK.**

8. Once you have selected a delegate, you need to set the level and type of permission that delegate will have. For each item (Calendar, Tasks, Inbox, Contacts, Notes, Journal) select the level of permission you want to grant:
   - **None:** delegate cannot access this feature of your account
   - **Reviewer:** delegate can read items
   - **Author:** delegate can read and add items
   - **Editor:** delegate can read, modify and add items

9. Click **OK** twice.

10. Provide each of your delegates with the instructions for adding an additional mailbox.
ADD AN ADDITIONAL MAILBOX: FOR DELEGATES

These instructions will allow you to add your resource account as an additional mailbox in your primary profile in Outlook 2007, 2010, 2011 for Mac, or 2013. Owners should see their resource account mailboxes already listed in their primary profile. You will need to provide these instructions to your delegates.

Outlook 2007

1. Choose Tools, select E-Mail Accounts.

2. Choose View or Change Existing E-mail Accounts. Click Next.


4. Select Change.

5. Choose More Settings, and select the Advanced tab.

6. In the Add Mailbox dialog box, enter the name of the mailbox you want to open, and then click OK. Outlook will try to match the mailbox name against the Global Address List and, if successful, will add it to the Open These Additional Mailboxes list.

7. When you’ve finished adding mailboxes, click OK to return to the Information Viewer. When you add a mailbox to your profile, you get immediate access to it in the Folder List. It is not necessary to exit and restart Outlook.

 Reminder:

You must either CC or BCC this resource account every time you send a message from this account. This way a copy of the sent item will be in the resource account’s sent items folder. There will also be a copy of the sent item in your personal sent items folder.
Outlook 2010

1. In the orange File ribbon tab, click Info, then Account Settings, and Account Settings…

2. Select your default account and click Change…

3. Click on More Settings…
4. Select the **Advanced** tab and then click on **Add**.

5. Enter the name of the additional mailbox into the **Add mailbox** field. Click **OK**, then **Next**, and **Finish**.

The new mailbox should now be located in your Navigation Pane beneath your main mailbox.

**Reminder:**

You must either **CC** or **BCC** this resource account every time you send a message from this account. This way a copy of the sent item will be in the resource account’s sent items folder. There will also be a copy of the sent item in your personal sent items folder.
Outlook 2011 for Mac

1. Click the Tools drop-down menu, and select Accounts.

2. Select your primary user account.

3. Click Advanced.

4. Click the Delegates tab.

5. In the bottom half of the window, under People I am a delegate for, click Add +.
6. Type the name of the resource account that has added you as a delegate, and then click Find.

7. Click the account's name, and then click **OK**.

8. Click **OK** again.

**Reminder:**
You must either **CC** or **BCC** this resource account every time you send a message from this account. This way a copy of the sent item will be in the resource account’s sent items folder. There will also be a copy of the sent item in your personal sent items folder.
Outlook 2013

1. In the blue File ribbon tab, click Info, then Account Settings, and Account Settings…

2. Select your default account and click Change...

3. Click on More Settings…
4. Select the **Advanced** tab and then click on **Add**.

5. Enter the name of the additional mailbox into the **Add mailbox** field. Click **OK**, then **Next**, and **Finish**.

6. The new mailbox should now be located in your Navigation Pane beneath your main mailbox.

**Reminder:**
You must either **CC** or **BCC** this resource account every time you send a message from this account. This way a copy of the sent item will be in the resource account’s sent items folder. There will also be a copy of the sent item in your personal sent items folder.